This manual belongs to:
COPYRIGHT

We reserve all rights to this document, even in the event that a patent is issued and a different commercial proprietary right is registered. Improper use, in particular reproduction and dissemination to third parties, is not permitted.

This document has been carefully checked. However, in case any errors are detected, the reader is kindly requested to notify the manufacturer at the address below.

The data contained in this manual is intended solely for the concept or product description and is not to be deemed to be a statement of guaranteed properties. In the interests of our customers, we constantly seek to ensure that our products are developed to the latest technological standards.

As a result, it is possible that there may be some differences between the HW/SW product and this information product.

Industrial IT

Industrial IT enabled products from ABB are the building blocks for greater productivity, featuring all the tools necessary for lifecycle product support in consistent electronic form.

Manufacturer:
ABB Automation Technologies AB
Substation Automation
SE-721 59 Västerås
Sweden
Telephone: +46 (0) 21 34 20 00
Facsimile: +46 (0) 21 14 69 18
www.abb.com/substationautomation
## Chapter

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>5</td>
</tr>
<tr>
<td>Intended use of this manual</td>
<td>5</td>
</tr>
<tr>
<td>Glossary</td>
<td>5</td>
</tr>
<tr>
<td>Intended audience</td>
<td>6</td>
</tr>
<tr>
<td>Responsibilities</td>
<td>6</td>
</tr>
<tr>
<td>References</td>
<td>7</td>
</tr>
<tr>
<td>Application</td>
<td>9</td>
</tr>
<tr>
<td>Parameter Setting Tool (PST)</td>
<td>9</td>
</tr>
<tr>
<td>Navigation environment</td>
<td>9</td>
</tr>
<tr>
<td>Communication</td>
<td>9</td>
</tr>
<tr>
<td>Requirements</td>
<td>13</td>
</tr>
<tr>
<td>PC, operative system and help viewer</td>
<td>13</td>
</tr>
<tr>
<td>Navigation environment</td>
<td>14</td>
</tr>
<tr>
<td>CAP 540</td>
<td>14</td>
</tr>
<tr>
<td>MicroSCADA</td>
<td>14</td>
</tr>
<tr>
<td>SMS 510</td>
<td>14</td>
</tr>
<tr>
<td>How to install PST</td>
<td>15</td>
</tr>
<tr>
<td>Install PST</td>
<td>15</td>
</tr>
<tr>
<td>Installing the PST documentation</td>
<td>18</td>
</tr>
<tr>
<td>Uninstall PST</td>
<td>20</td>
</tr>
<tr>
<td>PST network setup</td>
<td>20</td>
</tr>
<tr>
<td>How to use PST</td>
<td>23</td>
</tr>
<tr>
<td>Overview</td>
<td>23</td>
</tr>
<tr>
<td>Configure the navigation environment</td>
<td>23</td>
</tr>
<tr>
<td>Configuration in CAP 540</td>
<td>24</td>
</tr>
<tr>
<td>Configuration in MicroSCADA</td>
<td>24</td>
</tr>
<tr>
<td>Configuration in SMS 510</td>
<td>24</td>
</tr>
<tr>
<td>PST in network environment</td>
<td>24</td>
</tr>
<tr>
<td>Start PST</td>
<td>24</td>
</tr>
<tr>
<td>Start from CAP 540</td>
<td>24</td>
</tr>
<tr>
<td>Start from MicroSCADA</td>
<td>26</td>
</tr>
<tr>
<td>Start from SMS 510</td>
<td>26</td>
</tr>
<tr>
<td>Customize the behaviour of PST</td>
<td>27</td>
</tr>
</tbody>
</table>
Select the behaviour of reading and writing of parameters...................... 27
Set up the communication ........................................................................ 28
Unlock terminal ........................................................................................ 30
Change parameter values........................................................................ 30
Open a terminal instance with default or saved values......................... 30
Open a template ........................................................................................ 31
Open a compressed file ........................................................................... 32
Off-line adjustment of terminal options ................................................. 33
Off-line adjustment of the rated current setting ...................................... 34
PST value synchronization ....................................................................... 35
Copy Parameter Data/Paste Parameter Data............................................. 37
Navigate in the terminal tree ................................................................. 38
Change a parameter value........................................................................ 38
Save the parameter values...................................................................... 39
Work with setting groups........................................................................ 40
Read parameter values from a terminal.................................................... 41
Read options ........................................................................................... 42
Read all parameter values ....................................................................... 42
Read selected parameter values .............................................................. 43
Read dialog ............................................................................................... 43
Save last read .......................................................................................... 44
Compare tool parameter values with terminal values ......................... 44
Compare with terminal ............................................................................ 44
View differences ..................................................................................... 45
Write parameter values to a terminal ...................................................... 47
Write all parameter values ...................................................................... 47
Write selected parameter values to the terminal .................................... 48
Print parameters....................................................................................... 49
Change the header and footer information ............................................. 50
Print to a printer ..................................................................................... 52
Print to a file .......................................................................................... 55
Save parameter values for an entire terminal instance........................ 56
Save as a template .................................................................................. 56
Save as a compressed file ...................................................................... 57
Exit PST .................................................................................................. 58
Process Terminator................................................................................ 59

Graphical User Interface (GUI) ................................................................. 63
Main window ........................................................................................... 63
Terminal tree ......................................................................................... 63
Parameter view ....................................................................................... 65
Menus ...................................................................................................... 66
Tool bar .................................................................................................... 70
Differences window ................................................................................ 71
Menus ...................................................................................................... 71
Help......................................................................................................... 72
System errors and messages ................................................................... 73
1 Introduction

1.1 Intended use of this manual

This manual provides information on how to install and use the Parameter Setting Tool (PST). It also specifies PC requirements.

PST is a tool for managing parameters for monitoring, service values, protection and control terminals and relays. It is a MS Windows application intended to run on a standard PC.

1.2 Glossary

This chapter explains some key expression and abbreviations used in this manual.

Table 1: Glossary

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMP</td>
<td>Abbreviation for Bitmap - one (of many) format of a graphical file.</td>
</tr>
<tr>
<td>CAP 531</td>
<td>The programming and configuration tool used for the REx5xx series of terminals.</td>
</tr>
<tr>
<td>Clipboard</td>
<td>Windows Clipboard.</td>
</tr>
<tr>
<td>Compressed file</td>
<td>A file with the extension .zpt that stores all the parameter values for a terminal instance. A compressed file can be moved to another project or computer.</td>
</tr>
<tr>
<td>INI file</td>
<td>Standard Windows INI file (*.ini).</td>
</tr>
<tr>
<td>Level</td>
<td>Each item (folder) in the terminal tree.</td>
</tr>
<tr>
<td>LIB 510</td>
<td>MicroSCADA application software library for medium voltage.</td>
</tr>
<tr>
<td>LIB 520</td>
<td>MicroSCADA application software library for high voltage.</td>
</tr>
<tr>
<td>LON</td>
<td>Communication protocol: (Local Operating Network).</td>
</tr>
<tr>
<td>MicroSCADA</td>
<td>SCADA system from ABB.</td>
</tr>
<tr>
<td>Navigation environment</td>
<td>The tool from which PST is started (CAP 540, MicroSCADA, etc.)</td>
</tr>
<tr>
<td>Parameter</td>
<td>Single parameter setting for the terminal.</td>
</tr>
<tr>
<td>Parameter input field</td>
<td>A field for a parameter in the Parameter view were a new value can be entered.</td>
</tr>
<tr>
<td>Parameter level</td>
<td>The leaves of the Terminal tree, were parameters are presented in the Parameter view.</td>
</tr>
<tr>
<td>Parameter Setting Tool</td>
<td>The tool this manual describes. Referred to in the text as PST or &quot;the tool&quot;.</td>
</tr>
<tr>
<td>Parameter view</td>
<td>The right window in the tool that shows the parameter values or information of the terminal sub-levels.</td>
</tr>
<tr>
<td>Picture function</td>
<td>Graphical element within a process picture.</td>
</tr>
</tbody>
</table>
Table 1: Glossary (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process picture</td>
<td>Graphical display used in the MicroSCADA environment from where the terminal navigation is made.</td>
</tr>
<tr>
<td>Product family</td>
<td>The family name for a series of terminals that PST handles as an entity, for instance REX500.</td>
</tr>
<tr>
<td>PST</td>
<td>Abbreviation for Parameter Setting Tool.</td>
</tr>
<tr>
<td>RIO</td>
<td>Relay Interface by OMICRON.</td>
</tr>
<tr>
<td>SPA</td>
<td>Asynchronous ASCII communication protocol from ABB.</td>
</tr>
<tr>
<td>SVT</td>
<td>Abbreviation for Settings Visualisation Tool.</td>
</tr>
<tr>
<td>Terminal</td>
<td>A common name for a target unit (terminal, relay, controller, etc.) that the tool can read and write parameters to.</td>
</tr>
<tr>
<td>Terminal instance</td>
<td>A specific terminal that the parameter setting tool just is working with.</td>
</tr>
<tr>
<td>Terminal level</td>
<td>The upper-most level in the Terminal tree.</td>
</tr>
<tr>
<td>Terminal tree</td>
<td>The left browsing window in the tool that shows the structure of the terminal instance.</td>
</tr>
<tr>
<td>Terminal sub-level</td>
<td>A level in the Terminal tree between the terminal level and a parameter level.</td>
</tr>
<tr>
<td>Template</td>
<td>A template stores all parameter values for a terminal instance. A template is unique in a product family and cannot be moved to another computer. Standard templates for the product families are installed at PST installation time.</td>
</tr>
<tr>
<td>Terminal type</td>
<td>A specialization of a product family. For instance, REO517 is a terminal type in the product family REX500.</td>
</tr>
</tbody>
</table>

1.3

**Intended audience**

This manual can be used by installers, commissioners and system engineers.

1.3.1

**Responsibilities**

In order to fully understand the contents of this manual, you should have basic engineering knowledge and specific knowledge in substation automation, depending on your purpose.
1.4 References

The following manuals provide complementary information:

7. SVT (Settings Visualisation Tool), User’s Manual.
Introduction
2 Application

2.1 Parameter Setting Tool (PST)

PST is a tool for managing parameters for monitoring, service values, protection and control functions. You can read the parameters from a terminal, edit the parameter values and write the parameter values to a terminal. You can also edit your parameters in advance and write them to the terminal when it is available.

PST can be used for a variety of terminals (product families) with the same user interface.

2.1.1 Navigation environment

PST is delivered as a part of the navigation environment that is selected. The supported navigation environments are CAP 540, MicroSCADA and SMS 510.

2.1.2 Communication

PST utilizes different ways of communicating with the terminals.

In the CAP 540 environment, communication with SPA is supported. CAP 540 does not support LON or LONMark using a LON communication card (PCLTA). See figure 1.

In the CAP 540 environment, PST can work in a distributed network of computers either on the LAN or using a RAS connection.

Communicating via MicroSCADA, SPA and LON are supported. Communication using LONMark is not supported. In the MicroSCADA environment, PST can work in a distributed network of computers either on the LAN or using a RAS connection. See figure 2.

SMS 510 supports the same types of communication as MicroSCADA. See figure 3.
Figure 1: Communication overview in CAP 540 environment

Figure 2: Communication via MicroSCADA
Figure 3: Communication via SMS 510
3 Requirements

3.1 PC, operative system and help viewer

<table>
<thead>
<tr>
<th>Item</th>
<th>Minimum required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor / Frequency</td>
<td>Pentium / 233 MHz</td>
</tr>
<tr>
<td>RAM</td>
<td>128 MByte</td>
</tr>
<tr>
<td>Disk space</td>
<td>500 MByte</td>
</tr>
<tr>
<td>Monitor / Resolution</td>
<td>VGA compatible / 800 x 600, 256 colors</td>
</tr>
<tr>
<td>CD-ROM</td>
<td>Needed to install PST</td>
</tr>
<tr>
<td>Printer</td>
<td>300 dpi</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Operative System</th>
<th>Add-On's</th>
<th>Help viewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 95</td>
<td>DCOM 95</td>
<td>Internet Explorer 4 or later</td>
</tr>
<tr>
<td>Windows 98</td>
<td>DCOM 98 second edition</td>
<td>Internet Explorer 4 or later</td>
</tr>
<tr>
<td>Windows NT 4.0</td>
<td>Service Pack 4 or higher</td>
<td>Internet Explorer 4 or later</td>
</tr>
<tr>
<td>Windows 2000</td>
<td>–</td>
<td>Internet Explorer 4 or later</td>
</tr>
<tr>
<td>Windows XP Professional</td>
<td>Service Pack 1</td>
<td>Internet Explorer 4 or later</td>
</tr>
</tbody>
</table>

Note!

Internet explorer and Acrobat reader can be found on the installation-CD.
3.2 Navigation environment

3.2.1 CAP 540
The following product releases are needed to use PST from CAP 540:

Table 4: Requirements on CAP 540

<table>
<thead>
<tr>
<th>Tool</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAP 540</td>
<td>1.1 or higher</td>
</tr>
</tbody>
</table>

3.2.2 MicroSCADA
The following product releases are needed to use PST from MicroSCADA:

Table 5: Requirements on MicroSCADA

<table>
<thead>
<tr>
<th>Tool package</th>
<th>Release</th>
<th>Tool</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>MicroSCADA Base</td>
<td>-</td>
<td>-</td>
<td>8.4.3 or higher</td>
</tr>
<tr>
<td>LIB 500</td>
<td>4.0.3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LIB 510</td>
<td>4.0.3</td>
<td>SPA Tool</td>
<td>4.0.3 or higher</td>
</tr>
<tr>
<td>LIB 520</td>
<td>4.0.3-1 or higher</td>
<td>HVREX 500</td>
<td>3.0 or higher</td>
</tr>
<tr>
<td>LIB 520</td>
<td>4.0.3-1 or higher</td>
<td>HVRET 521</td>
<td>3.0 or higher</td>
</tr>
</tbody>
</table>

3.2.3 SMS 510
The following product releases are needed to use PST from SMS 510:

Table 6: Requirements on SMS 510

<table>
<thead>
<tr>
<th>Tool</th>
<th>Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMS 510</td>
<td>1.0.0 with service pack 2 or higher</td>
</tr>
</tbody>
</table>
4 How to install PST

Depending on the navigation environment, PST is installed in different ways. Whether the navigator environment is CAP 540, MicroSCADA or SMS 510, the PST is installed separately from the rest of the system. For CAP 540 please see reference [1], for MicroSCADA, please see reference [3] and for SMS 510, please see reference [5]. The installation of PST is the same for these environments and is described in instructions in this chapter.

Note!
When installing in Windows NT, Windows 2000 and Windows XP, you need to log on as administrator.

4.1 Install PST

This section describes how to install PST in the basic version of CAP 540, MicroSCADA and SMS 510 environment. The full version of CAP 540 includes configuration and is installed together with PST. See reference [2] for this installation procedure.

The first steps in the installation instruction (where to find the installation file PST-Setup.exe etc.) is described in the manuals for the navigation environment, references [3] and [5] respectively. When the installation starts the following dialog appears.

![Welcome dialog](Image)

Figure 4: Welcome dialog
• Read the message and click OK if you want to continue with the installation.

The following dialog appears:

![License Agreement dialog](image)

**Figure 5: License Agreement**

• Read the License Agreement and click Agree to continue the installation.

The following dialog appears:

![Select Terminal Libraries dialog](image)

**Figure 6: Select Terminal Libraries dialog**
Note!

If the MicroSCADA system is run as a Hot standby system it is necessary to enable selection of instance destination.
When this function in the installation script is selected it enables selection of the path to the MicroSCADA application where PST instances shall be located.

- Select the check boxes for all terminal libraries you want to install.
- If you want to change the destination for the CAP 531 installation, click the Change button to the right of the CAP 531 destination box.
- If you want to change the destination for the PST installation, click the Change button to the right of the PST destination box.
- Click Next.
The following dialog appears.

![System Information dialog](image)

Figure 7: System Information dialog

- Check the information and choose one of the following two steps:
  - To reenter any information, click Back.
  - To start the installation, click Install.
The PST software is now being installed into your computer, showing you an installation progress bar.
How to install PST

- When the installation is complete, click OK to restart your computer.
  After restarting your computer, you can begin using the tools and the terminal libraries in the PST software package.

The installation sets up the following program entries in the start menu under Programs\PST.

![PST start menu](image)

*Figure 8: PST start menu*

The help function in the Parameter Setting Tool uses Internet Explorer. If you do not have Internet Explorer on your computer, you have to install it.

**Note!**
*The PST cannot be started from the program start menu. It is always started from its navigation environment: MicroSCADA, SMS 510 or CAP 540.*

4.2 Installing the PST documentation

This section describes how to install the documentation for PST.

The first steps in the installation instruction (where to find the installation file pst-doc.exe etc.) is described in the manuals for the navigation environment, references [3] and [5] respectively. When the installation starts the following dialog appears.

![Welcome dialog](image)

*Figure 9: Welcome dialog*
• Read the message and click OK if you want to continue with the installation.
  The following dialog appears.

![Destination - PST Documentation Installation]

*Figure 10: Select destination drive and folder for the documentation*

• Select the drive and the folder where the PST documentation shall be installed, and then click Next.
  The following dialog appears.

![System Information - PST Documentation Installation]

*Figure 11: System information dialog for documentation*
How to install PST

- Check the information and do one of the following:
  - To reenter any information, click Back.
  - To start the installation, click Install.

The PST documentation is now being installed into your computer, showing you an installation progress bar.

- When the installation is complete, click OK.

The installation sets up documentation entries in the start menu under Programs\PST

Note!
*The documents are in pdf-format, and you need Acrobat Reader to view them.*

4.3 Uninstall PST

There is no uninstall for the PST.

4.4 PST network setup

This section describes how to setup the network model for PST. The setup must be done for all involved computers in the network when you are using PST in a remote mode together with CAP 540, SMS 510 or MicroSCADA. PST Network setup enables remote access between PST running in a station PC and PST running in a client PC.

- Start the program PstNetworkSetup.exe.

You find it in the Start Menu under Programs\PST.

The following dialog appears.

![PST Network Installation dialog](image)

*Figure 12: PST Network Installation dialog*
How to install PST

- **Under Network Model, click the appropriate button.**
  - Peer-to-Peer model means that computers are connected as workstations.
  - NT Domain Server means that an NT Server is set up as a domain server.

- **Click Install**

  The network support is now installed for the network model you have selected.

It is essential that the same PST-version is installed on both the client and server computers. The operating system must also be the same on the client and server computers. Map the IP address and the PC name in the hosts file (located in: \winnt\system32\drivers\etc). See the hosts file for examples how to do this. Note that the client PC must be aware of the server PC and that the server PC must be aware of all client PC’s involved in the system.

A shortcut to the hosts file entries can be found by pressing the “Hosts Setup” button in the “PST Network Installation” dialog.

**Note!**

*The client PC must be aware of the server PC which in turn must be aware of all client PC’s involved in the system.*
How to install PST
5 How to use PST

5.1 Overview

This chapter describes how PST is used for different operations, such as:

- changing parameter values
- handling of setting groups
- writing of the parameter values to a terminal
- reading of the parameter values from a terminal
- saving and reading the parameter values as templates (for reuse in the project)
- saving and reading the parameter values as compressed files (for reuse in other projects and computers)
- printing the parameters
- comparing the parameters in the tool with parameters in the terminal.
- monitoring
- service values
- rated current

In order to use PST it must be installed in your computer, see “How to install PST” on page 15. To start PST, there must also be a terminal inserted in the navigation environment that you are using. To read and write parameter values from or to a terminal, the communication parameters must be set up, and a physical connection to your terminal must be available.

The work starts with defining an application structure in the navigation environment. After that you have to make the communication setup, e.g. enabling PST to communicate with the appropriate terminal. Then you can either read the parameter values from your terminal, define them off-line, get them from a template or get them from a saved file. When the parameter values are set, they can then be written to your terminal. Finally you can print your parameters and save them for reuse in the project (template) or reuse in other projects and computers (compressed file).

5.2 Configure the navigation environment

This section describes how to configure the navigation environment. In order to use PST, the navigation environment must be configured to reflect the terminal instances you have in your project or organization.
How to use PST

5.2.1 Configuration in CAP 540
To use CAP 540 as your navigation environment, the project tree in the CAP 540 must be built. In this tree, you add the terminal instances for all units for which you want to use the PST. This is described in detail in reference [1].

PST can be used in a network of computers when CAP 540 is the navigation environment.

5.2.2 Configuration in MicroSCADA
To use MicroSCADA as your navigation environment, process pictures must be built that contains the picture functions for the terminal instances for which you want to use PST. This is described in detail in reference [3] and [4].

PST can be used in a network of computers when MicroSCADA is the navigation environment.

5.2.3 Configuration in SMS 510
To use SMS 510 as your navigation environment, the project structure must be built that includes the terminal instances for which you want to use PST. This is described in detail in reference [5].

PST can be used in a network of computers when SMS 510 is the navigation environment.

5.3 PST in network environment
To use PST in a network, the PST need to be installed on all involved computers, i.e. on all client computers as well as on the server computer. The installation is made during the installation of the navigation environment. You need also to setup the network. See “How to install PST” on page 15 for details on installation and setting up the network.

5.4 Start PST
This section describes how to start PST. You can start it from the navigation environment you have installed. From CAP 540 you start the PST from the project tree or from a function block within the configuration worksheet. In MicroSCADA you start from a process picture. In SMS 510 you start from the project structure.

5.4.1 Start from CAP 540
5.4.1.1 Start from the project tree
You can start PST from the project tree in CAP 540.

- In the project tree, select the wanted terminal instance.
- With a right click select Parameter Settings.
  
PST starts for the selected terminal instance, showing the top terminal level.


Note!
For product families with currently no support for PST, the Parameter Setting command on the edit menu will be disabled.

5.4.1.2 Start from a function block within a worksheet in CAP 531
You can start PST from a function block in the configuration tool.

- Open a work sheet for the wanted terminal instance.
- With the right or left mouse button, double-click the wanted function block.
  
The Function Block dialog appears.

- Click Parameter Settings
  
PST starts for the wanted terminal instance, showing the parameter level that corresponds to the selected function block.


Note!
It is only possible to start PST from function blocks that have associated settings. For all other function blocks, the Parameter Setting button will be disabled in the Function Block dialog.
5.4.2 Start from MicroSCADA
You can start PST from a process picture in MicroSCADA.

- Select the process picture with the picture function for the wanted terminal instance.

![System Supervision 2.0](image)

*Figure 13: Example of PST start in a MicroSCADA process picture*

- Click the PST terminal object
  PST starts, showing the top terminal level.

See references [3] and [4] for more details on the handling in MicroSCADA.

5.4.3 Start from SMS 510
You can start PST from the project structure in SMS 510.
How to use PST

- **In the project structure, select the wanted terminal instance.**
  PST is now visible in the Object Tools list.

- **Double-click PST in the Object Tools list.**
  PST starts, showing the top terminal level.

5.5 **Customize the behaviour of PST**
This section describes how you customize some of the functionality in PST.

5.5.1 **Select the behaviour of reading and writing of parameters**
- **On the Edit menu, click Customize.**
  The following dialog appears.

![Customize dialog](image)

*Figure 14: The customize dialog for reading and writing of parameters*
• Select the appropriate check boxes.

<table>
<thead>
<tr>
<th>Check box</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read back parameters after a Write to Terminal</td>
<td>The commands ‘Write to Terminal</td>
</tr>
</tbody>
</table>

Table 7: Customize check boxes

5.5.2 Set up the communication

The communication setup is done in the navigation environment MicroSCADA, (reference [4]), CAP 540 (reference [1]) or in SMS 510 (references [5] and [6])

You can however read how the communication is configured:

• **On the Online menu, click Setup**

  The following dialog appears:

  ![Communication setup read only message]

  *Figure 15: Communication setup read only message*

• **Click OK.**

  The following dialog appears:
How to use PST

Figure 16: Communication setup dialog (read-only)

- Click Configure.

The following dialog appears when your protocol is SPA.

Figure 17: SPA protocol communication parameters

When your protocol is LON, the following dialog appears.

Figure 18: Communication dialog for the LON protocol
5.5.3 Unlock terminal

There is a lock in the terminal that will prevent two concurrent connections (i.e. front and backside communication) from accessing information from different setting groups. The terminal will respond with a code to indicate that the setting group is locked if a request is made to access a different setting group than the locked one.

One problem that can arise with this sort of logic is if a lock command is issued and accepted by the terminal, but the communication is interrupted before the unlock command is received by the terminal. A special unlock feature is available in the setup dialog to eliminate this problem. Simply check the Unlock box and an unlock command will be issued to the terminal the next time a communication command is issued. The check box will be cleared automatically after the communication attempt.

The reason why the command is not always used is to insure safety at all times. The operator must before the check box is checked be sure that no other interfering communication will be performed.

5.5.4 Change parameter values

This section describes how PST is operated in order to define new values for the parameters. How to work with setting group is also described.

Start by opening a template, by reading a compressed file or by reading the values from a terminal, or just start with the parameter values you have earlier saved for your terminal in PST. Then make your changes to the parameters, and save them in the tool. To simplify your work with several setting groups, you can also copy all parameter values from one setting group to another.

5.5.5 Open a terminal instance with default or saved values

The first time you start PST for a terminal instance, every parameter has a default value. For the definition of “terminal instance”, see 1.2 “Glossary” on page 5.

The next time you start PST for that terminal instance, you will get the parameter values you saved the last time you worked with it.

Note!

*Once you have changed parameters in a terminal instance, you cannot return to the default values for that instance. Instead you can open a template that has default values on the parameters, or, create a new terminal instance in the navigation environment that starts with the default values on the parameters.*

How you open a terminal instance from different navigation environments is described in “Start PST” on page 24.
5.5.6 **Open a template**

You can open a template that earlier has been saved in your project. Templates stores the setting values for an entire terminal.

- **On the File menu, point to Template, and then click Open.**
  
  After templates are made, the following dialog appears.

![Open template dialog](image)

*Figure 19: Open template dialog*

- **In the Templates box, select the template you want to open, and then click Open.**
  
  The following dialog appears.

![Overwrite current tool data dialog](image)

*Figure 20: Overwrite current tool data dialog*

- **Click Yes.**
  
  The template data is loaded.

  If you instead click No, the opening of the template is interrupted and the old data is kept in the tool.

---

**Note!**

*A template cannot be copied or moved to another project or computer. Use Compressed files instead when the data for a terminal instance need to be copied.*
You cannot open a template for a different terminal module than the one that you are working with. In figure 19, “Open template dialog” on page 31, you will only see the templates for the current terminal module.

The templates in PST and CAP 531 are handled separately. That is, the templates in PST covers only the parameters for a terminal, not the configuration.

5.5.7 Open a compressed file

Before you can open a compressed file there must exist a compressed file. The file is created by the Compress command on the File menu, or the file is copied from another project or computer.

You can open a compressed file that has been saved earlier. Compressed files stores the PST values and terminal values for an entire terminal instance. Compressed files can be moved to other projects or computers. The file extension is .zpt.

- On the File menu, click Decompress.
  The following dialog appears.

![Decompress file dialog](image)

Figure 21: Decompress file dialog

Only files with the extension “.zpt” are visible.

- Select the folder and the file name of the file you want to decompress, and then click Decompress.
  The following dialog appears.

![Open Template](image)

Figure 22: Overwrite current tool data dialog
How to use PST

- Click OK.
  The data from the compressed file is loaded.
  If you instead click No, the opening of the compressed file is interrupted and the old data is kept in the tool.

- Decide whether to also save terminal values.
  Select Yes if you want to decompress terminal values.

![Image of Decompress window]

Figure 23: Decompress PST and terminal values

Note!

It is not possible to decompress a file that was compressed for a different terminal type than the one that you are working with. If you do so anyway, you will get an error message and the Decompress command will be cancelled.

5.5.8 Off-line adjustment of terminal options

For efficient off-line engineering it is possible to adjust the function library to exactly reflect the functions delivered in the terminal, without having to upload options from the terminal.

![Image of Parameter Setting Tool]

Figure 24: Menu for off-line adjustment of terminal options
• **On the Edit menu, click Terminal options.**  
  A dialog (shown below) is displayed.

• **Select .opf-file which reflect your terminal options.**

![Terminal options browsing](image)

*Figure 25: Terminal options browsing*

### 5.5.9 Off-line adjustment of the rated current setting

You can adjust the rated current off-line.

By doing this the ranges for the rated current dependent settings will be changed accordingly.

You also have the possibility to scale the rated current dependent settings automatically.

---

**Note!**

*Any unsaved PST values will be lost by performing the auto-scale. Please save your setting values.*
How to use PST

- On the Edit menu, click rated current.
- Set 1 or 5 ampere according to your terminal setup.

![Set Rated Current](image)

*Figure 26: Set rated current off-line*

- Press the OK button.
- Choose to scale/not to scale the dependent settings in the following message box.

If you select Yes:
- If you have changed the rated current from 1A to 5A the impedance settings will be divided by five.
- If you have changed the rated current from 5A to 1A the impedance settings will be multiplied by five.

If you select No:
- No scaling of impedance settings will be made.

![PST](image)

*Figure 27: Select auto-scaling*

**5.5.10 PST value synchronization**

To verify that all PST values are within a valid range, the “PST Value Synchronization” function can be used. Open the Edit menu and select PST Synchronizer.
Parameters with values outside the valid range will be updated with default values if you click Yes in the dialog.

![Update values outside valid range dialog](image1)

*Figure 28: Update values outside valid range dialog*

The function will be executed and the parameters with illegal values are updated with default values, and also displayed in the PST Synchronizer window. The path to where the changed parameters can be found is displayed together with the parameter name, setting group number, replaced value and new value (default value).

If no illegal values were found, the left hand side of the PST Synchronizer window only contains the "ROOT" node.

![PST Synchronizer window](image2)

*Figure 29: PST Synchronizer window*

The menu in the PST Synchronizer window consists of Save As and Exit.

![PST Synchronizer window menu](image3)

*Figure 30: PST Synchronizer window menu*
How to use PST

![Save As menu](image)

**Figure 31: Save As menu**

An example of the saved file:


<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>SETTING GROUP NO</th>
<th>REPLACED VALUE</th>
<th>NEW VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>LB</td>
<td>1</td>
<td></td>
<td>1.0</td>
</tr>
<tr>
<td>TScale</td>
<td>1</td>
<td>2006.000</td>
<td></td>
</tr>
<tr>
<td>T2b</td>
<td>3</td>
<td>2006.000</td>
<td></td>
</tr>
<tr>
<td>T4b</td>
<td>2</td>
<td>1.0</td>
<td></td>
</tr>
<tr>
<td>UTb</td>
<td>2</td>
<td>63.32</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 32: File example**

### 5.5.11 Copy Parameter Data/Paste Parameter Data

You can copy parameter data from the current terminal instance at any level in the Terminal tree.

The copied data can be pasted into another terminal instance meaning that the copied data will remain in the copy buffer until the next copy request is performed. Note that you can also copy data between different terminal versions meaning that you can upgrade a terminal to a new version and reuse your existing parameter settings. Also note that it is not possible to copy data between any terminal type and version. PST will tell if the Paste operation is valid for a specific terminal type and version.
5.5.12 **Navigate in the terminal tree**

You can select different levels in the terminal tree depending on which parameters you want to change. You select levels by double-clicking the level icons or by clicking the plus and minus signs in front of the level icon in the tree.

- **Point on a level in the terminal tree that you want to expand, and then double-click.**

  You can also click the plus sign in front of the level icon.

  Continue to expand the levels until you reach your wanted parameter level. The parameters are then presented in the parameter view window.

5.5.13 **Change a parameter value**

Before you can change any parameter values you must have navigated to a parameter level in the terminal tree.

You can change the value of a parameter by entering new values in the parameter input fields in the parameter view.

There are two types of input fields:

- writable boxes
- lists of predefined values

For a parameter that has a writable box:

- **Type the new parameter value in the box.**

  The new value appears in bold blue.

  If you enter illegal values such as values outside ranges, wrong step or wrong format, you get an error message and the illegal value is highlighted. Now you can enter a valid value for the parameter. CTRL + Z will bring back the old value.

For a parameter that has a list of predefined values:

- **Click the arrow of the list.**

  All predefined values are shown, see example in figure 33.

*Figure 33: Example of opened list in the parameter view.*
• **In the list, click a value of your choice.**
  
The value is selected as the new parameter value and appears in bold blue.

**5.5.14**

**Save the parameter values**

You need to save the values you have changed in order to make them available for the tool.

You can do this in two ways:

- by a menu command
- from the tool bar

To save the parameters by a menu command:

• **On the File menu, click Save.**

  All changed values are saved in PST. The parameter values that was marked changed with bold blue, are now presented with normal style.

To save the parameters from the tool bar:

• **On the tool bar, click Save.**

  All changed values are saved in PST. The parameter values that was marked changed with bold blue, are now presented with normal style.

**Note!**

*There are no menu commands to discard changed values. If you try to exit the tool, try to copy setting groups or view differences, without saving the changed values, you get a dialog in which you can select to save the changes or discard them.*

*Figure 34: Save the changed values dialog.*
5.5.15 Work with setting groups

This section describes how you work with setting groups. You can select which group you want to work with. Only one setting group at the time can be viewed. You can also copy all parameter values from one setting group to another. How to print parameter values from various setting groups is described in section “Print parameters” on page 49.

5.5.15.1 Select setting group

You can select which setting group you want view in two ways:

- by a menu command
- from the tool bar

To select the setting group by a menu command:

- On the View menu, click Setting Group.
  
  The following dialog appears.

![View Setting Group dialog](image)

Figure 35: View setting group dialog

- In the Setting Group box, type or select the setting group you want to view, and then click OK.
  
  The parameter values of the selected setting group are shown in the parameter view, whenever the terminal tree is browsed, until you change to another setting group.

To select the setting group from the tool bar:

- On the tool bar, in the Setting Group box, type or select the setting group you want to view.
  
  The parameter values of the selected setting group are shown in the parameter view, whenever the terminal tree is browsed, until you change to another setting group.

Note!

You cannot perform any setting group actions for parameter levels that do not belong to setting groups.
5.5.15.2 Copy values between setting groups

You can copy all parameter values from the selected setting group to another.

- **On the Edit menu, click Copy Settings**
  The following dialog appears.

![Copy Setting Group Dialog](image)

*Figure 36: Copy setting group dialog*

- **In the Destination box, type or select the setting group(s) you want to copy to, and then click OK.**
  All parameter values are now copied to the new setting group(s).

**Note!**

*If you try to copy the values to another setting group without saving the changed values, you get a dialog in which you can select to save the changes or discard them.*

![Save Changes Dialog](image)

*Figure 37: Save the changed values dialog.*

5.6 Read parameter values from a terminal

This section describes how to read parameter values from a terminal. All parameter values or a selection of parameters can be read.

To read parameter values from a terminal, the communication parameters must be set up according to section 5.5.2 “Set up the communication” on page 28 and there must be a physical connection to your terminal.
5.6.1 Read options

For products in the REx5xx series of terminals, the functionality of the terminal is controlled by options. Example of this are the various protective functions, the I/O boards, etc. Which parameters you can see in PST will then consequently be controlled by the options.

When parameter is read from the terminal for the first time, the options are also read, see section 5.6.2 “Read all parameter values” on page 42. In all the following readings from the terminal, the options will not be read. The options will also be read when you write any parameter to the terminal without ever before having read the parameters from the terminal. In both of these cases, the following dialog appears.

![Options dialog](image)

Figure 38: Read options dialog

If the functionality (options) of your terminal are changed after you have read the parameter once, you must manually read these options, or else there will most likely be errors when reading and writing parameters.

- **On the Online menu, click Read Options.**

The functionality available in the PST is now adapted to the functionality (options) in the terminal.

5.6.2 Read all parameter values

This section describes how to read all parameter values from a terminal.

- **On the Online menu, point to Read from Terminal, and then click All.**

  All Parameter values are read from the terminal to the Terminal value fields in PST.

  For option handling in the REx5xx series of terminals see section 5.7 “Compare tool parameter values with terminal values” on page 44.
5.6.3 Read selected parameter values
This section describes how to read a selected part of parameter values from a terminal.

- **Select a parameter level in the terminal tree.**
  All parameter values under this level forms the selection. If the parameters under this level is part of setting groups, only parameters in the selected group are included in the selection.

- **Do one of the following**
  - On the Online menu, point to Read from Terminal, and then click Selection.
  - On the toolbar, click Read from Terminal | Selection.
  The selected part of parameter values are read from the terminal to the Terminal value fields in PST.

For option handling in the REx5xx series of terminals see section 5.7 “Compare tool parameter values with terminal values” on page 44.

5.6.4 Read dialog
This section describes the functionality of the dialog after the parameters are uploaded to the PC. After the communication with the terminal is finished the user is presented the following dialog box.

![Save or compare dialog box](image)

*Figure 39: Dialog box after parameters have been uploaded*

After the parameters are uploaded the user has the following choices: Save, compare and cancel. Save will write the uploaded parameters to the PST values on the PC. Compare will make a comparison between the uploaded parameters and the corresponding PST values on the PC. Cancel will leave the uploaded parameters in the terminal value column with no further action.
5.6.5 Save last read

If the user select compare or cancel there is still a possibility to save the last read parameters to the PST values without uploading one more time. Under file on the menu select Save last read, and the PST values are updated with the uploaded values.

![Figure 40: Save last read](image)

5.7 Compare tool parameter values with terminal values

This section describes how to compare parameter values in the terminal and in PST, and how to view differences between the Terminal value fields and the PST value fields in the tool.

5.7.1 Compare with terminal

You can compare the parameter values in the terminal and in the tool. To compare parameter values, the communication parameters must be set up and a physical connection to your terminal must be available. You can compare the parameters in three ways:

- after upload of terminal values
- by a menu command
- from the tool bar

To compare parameters by a menu command:

- **On the Online menu, click Compare with Terminal.**

  All parameter values are read from the terminal to the Terminal value fields in the tool. Then the command ‘View Differences’ starts automatically, see section 5.7.2 “View differences” on page 45. For option handling in the REx5xx series of terminals, see section 5.7 “Compare tool parameter values with terminal values” on page 44.
To compare parameters from the tool bar:

- **On the tool bar, click Compare with Terminal.**

  All parameter values are read from the terminal to the Terminal value fields in the tool. Then the command ‘View Differences’ starts automatically, see section 5.7.2 “View differences” on page 45.

  For option handling in the REx5xx series of terminals, see section 5.7 “Compare tool parameter values with terminal values” on page 44.

### 5.7.2 View differences

You can view the differences between the Terminal value fields and the PST value fields. This command can be manually started, but it also starts automatically from the ‘Compare with Terminal’ command.

#### Note!

*The view differences command doesn’t read parameter values from the terminal. If you want to read from the terminal, please use ‘Compare with Terminal’, or ‘Read from Terminal|All’ instead.*

- **On the View menu, click Differences.**

  The following window appears.

![Differences window](image)

*Figure 41: Differences window*
For every parameter for every setting group that are not equal in the Terminal value field and in the PST value field, there is a line presented in the window, and the number of differences are shown in the status bar. No differences are indicated by the fact that there are no lines at all in the window, and the number of differences in the status bar says zero.

Note!

If you select to view the differences without saving the changed values, you get a dialog in which you can select to save or discard the changes before the differences are calculated. You can also select to cancel the Differences command.

5.7.2.1

Print differences

You can print the differences.

• In the Differences window, on the File menu, click Print.

The following dialog appears.

Figure 42: Handle changed values dialog

Figure 43: Print dialog
• In the Name box, select the printer you want to use, and then click OK. Save differences on a file

5.7.2.2

You can save the differences on a file. The items in the file are semicolon(;) separated.

• In the Differences window, on the File menu, click Save.

The following dialog appears.

![Save As dialog](image1)

*Figure 44: Save the changed values dialog*

• Select the folder and the name of the file you want to save the differences in, and then click Save.

The saved file can be opened by for instance Microsoft Excel, See “Open a printed file with Microsoft Excel” on page 55.

5.8

Write parameter values to a terminal

This section describes how to write parameter values to a terminal. All parameter values or a selection of parameters can be written. To write parameter values to a terminal, the communication parameters must be set up and a physical connection to your terminal must be established.

5.8.1

Write all parameter values

You can write all parameter values to a terminal.

• On the Online menu, point to Write to Terminal, and then click All.

The following dialog appears.

![Write to terminal dialog](image2)

*Figure 45: Write to terminal warning dialog*
• **Click OK**
  The changed values are saved and the writing to the terminal starts.

If you instead click Cancel, the *Write to Terminal* command will be cancelled.

If the check box “Read back values after a Write to Terminal” is selected in the customize dialog, there will be a read back of the parameter values from the terminal to the Terminal value fields in the tool, after they are written to the terminal.

For option handling in the REx5xx series of terminals see section 5.7 “Compare tool parameter values with terminal values” on page 44.

• **Special handling of MIM and AIM changes in RET 521**
  After a change of parameters for mA Input Module (MIM) or Analogue Input Module (AIM) in RET 521*2.0, 2.1 and 3.0, the respective MIM and AIM parameters must be saved with a *write selection* command. *write all does not activate settings on the MIM and AIM.*

  ![](image)

5.8.2  
**Write selected parameter values to the terminal**
You can write a selected part of the parameter values to the terminal.

![](image)

*Figure 46: Write to terminal | Selection dialog*
How to use PST

- **Select a parameter level in the terminal tree**
  All parameter values under this level forms the selection. If the parameters under this level is part of setting groups, only parameters in the selected setting group are included in the selection.

- **Do one of the following:**
  - On the Online menu, point to Write to Terminal, and then click Selection.
  - On the tool bar, click Write to Terminal | Selection.

  The following dialog appears.

  ![Write to terminal warning dialog](image)

  **Figure 47: Write to terminal warning dialog**

- **Click OK**
  The changed values are saved in the PST and the writing to the terminal starts.

  If you click Cancel, the Write to Terminal command will be cancelled.

  If the check box “Read back values after a Write to Terminal” is selected in the customize dialog, there will be a read back of the parameter values from the terminal to the Terminal value fields in the tool, after they are written to the terminal. Only the selected parameters that were written, are read back.

  For option handling in the REx5xx series of terminals see section 5.7 “Compare tool parameter values with terminal values” on page 44.

5.9 **Print parameters**

This section describes how to print the parameters.

Start by changing the header and footer information of the printout to suit your project and organization. Then you can choose to print the parameters on a printer or to a file. You can print all parameters for a terminal instance or a selected part of the parameters.
5.9.1 Change the header and footer information
You can change the information in the header and in the footer of your printout.

- On the File menu, click Print.
  The print dialog appears.

![Print dialog](image)

*Figure 48: The print dialog*

5.9.1.1 Value Selection
The user can choose to print PST values, terminal values or both, by choosing either "Terminal values" or "PST values" below Value Selection. Notice that at least one option has to be checked.

5.9.1.2 Font
When only one setting group is checked a larger font is used for printing.
How to use PST

- **Click Header/Footer**
  The following dialog appears.

![](image)

**Figure 49: Header/Footer information dialog**

The boxes in the footer area have the same names as you see them in the printout, see figure 51.

The maximum number of characters for each item is also indicated in the figure.

- **Type new values in the boxes.**
  The bitmap can for instance be your company logotype. The bitmap appears in the lower left corner of the printout, to the left of the ‘Company name’, see figure 51.

  Use a graphical tool like Microsoft Paint®, if you want to create a new bitmap file.

- **Click OK in the Header/Footer information dialog.**
  The changed header and footer information will now be used for your printouts for this terminal instance.

**Note!**

*Terminal instance specific information is automatically printed on the first sheet of your printout, see figure 51.*
Note!

The layout of the printouts is predefined and cannot be changed by the user. Only the header and footer information can be adapted.

5.9.2 Print to a printer

You can print the parameters on a printer.

There are two ways to do this:

- by a menu command
- in the tool bar

5.9.2.1 Print to a printer by a menu command

You can print the parameters on a printer by a menu command.

- On the file menu, click Print.

The print dialog appears.

![Print dialog](image)

*Figure 50: The print dialog*
Value selection

The user can choose to print PST values, terminal values or both, by choosing either "Terminal values" or "PST values" below Value Selection. Notice that at least one option has to be checked.

When only one setting group is checked a larger font is used for printing.

Make sure that the information in the header and footer are valid, see section 5.9.1 "Change the header and footer information” on page 50, before you start to print.

- In the Name box, select the printer you want to use.
- Do one of the following:
  - To print all parameters, click All in the Print range area.
  - To print a selection of parameters, click Selection in the Print range area. Activate then the main window of the tool, and select a level in the terminal tree.
    - All parameters under that level will be printed.
    - You can also select the level in the terminal tree before you start the print command.
- In the Setting Groups area, select the appropriate check boxes for the setting groups you want to print.
- In the Value Selection area, select the appropriate check boxes for the values you want to print.
• In the Number of copies box, type or select how many copies you want to print, and then click OK.

The printout starts. An example of a printout is displayed below.

![Image of printout]

**Figure 51: Example of a printout**

### 5.9.2.2 Print to a printer from the tool bar

You can print the parameters on a printer from the tool bar.

- **Select a level in the terminal tree.**  
  All parameters under that level will be printed.

- **On the tool bar, click Print.**  
  The printout starts, using the last entered values for:

  - printer name
  - number of copies
  - setting groups
  - header/footer item values

  in the print dialog (figure 50).

See figure 51 for an example of a printout.
5.9.3 Print to a file
You can print the parameters to a file. The items in the file are tabulator separated.

- On the File menu, click Print.
  The print dialog appears, see figure 50.

- Click Print to file.
- In the “Print to file” box: Write the path and the filename of the file you want to print to.
  The file extension.txt is used.

- Do one of the following:
  - To print all parameters, click All in the Print range area.
  - To print a selection of parameters, click Selection in the Print range area.
    Activate the main window of the tool, and select a level in the terminal tree.
    - All parameters under that level will be printed.
    - You can also select the level in the terminal tree before you start the print command.

- In the Setting Groups area, select the appropriate check boxes for the setting groups you want to print.

- In the Value Selection area, select the appropriate check boxes for the values you want to print.

- Click OK.
  The parameters are printed to the file with a tabulator separation mark. The terminal instance specific parameters are put first, then the header and footer information and the parameters. You can open the file with e.g. Microsoft Excel.

5.9.3.1 Open a printed file with Microsoft Excel
You can open a printed file in Microsoft Excel.

- Start Microsoft Excel.
- On the File menu click Open and select the file you want to open.
  The Text Import Wizard is started.
This section describes how the parameter values for a terminal instance can be saved as a template or as a compressed file. This section does not describe the saving of changed parameters on one level in the terminal tree. Information on this is found in section 5.5.14 “Save the parameter values”.

5.10 Save parameter values for an entire terminal instance

You can save the parameter values for a terminal instance as a template. The template can later be used for a quick-start when editing other terminal instances in your project. Templates store the setting values for an entire terminal.

- On the File menu, point to Template, and then click Save.

  The following dialog appears.

  ![Save template dialog](image)

  Figure 53: Save template dialog

- In the Template name box, type or select the name.
- In the Description box, type your description, and then click OK.

  The parameter values for your terminal instance are now saved as a template.
Note!

A template cannot be copied or moved to another computer. Use Compressed files instead when the data for a terminal instance need to be copied.

The templates in PST and CAP 531 are handled separately. The templates in PST covers only the parameters of a terminal and not the configuration.

If you try to save the parameter values as a template without saving the changed values, you get a dialog in which you can select to save the changes or discard them.

![Save the changed values dialog](image)

Figure 54: Save the changed values dialog

5.10.2 Save as a compressed file

You can save the parameter values for a terminal instance as a compressed file. Compressed files can be copied or moved to other projects or computers. Compressed files store the parameter values for an entire terminal instance.

- **On the File menu, click Compress.**
  The following dialog appears.

![Compress file dialog](image)

Figure 55: Compress file dialog
How to use PST

- Select the folder and the File name of the file you want to compress, and then click Save.
  
  You can only save compressed file with the extension “.zpt”.
  
  If you omit the extension in the file name, it will automatically be set to “.zpt”.
  
  The parameter values for your terminal instance are now saved as a compressed file.

- Decide whether to also save terminal values.

![Compress PST and terminal values](image)

*Figure 56: Compress PST and terminal values*

**Note!**

*If you try to save the parameter values as a compressed file without saving the changed values, you get a dialog where you can select to save the changes or discard them.*

![Save the changed values dialog](image)

*Figure 57: Save the changed values dialog*

5.11 Exit PST

This section describes how to exit PST.

- **On the File menu, click Exit.**

  An alternative way to exit is to press the Close button in the upper-right corner of the main window.

  The parameter tool exits for this terminal instance. The parameter values are remembered by the terminal instance until the next time it is started.
How to use PST

Note!
If you try to exit without saving the changed values, you get a dialog in which you can select to save the changes or discard them.

![Save the changed values dialog](image)

Figure 58: Save the changed values dialog.

5.12 Process Terminator

Sometimes when shutting down PST and CAP531 some processes (program parts) are still running. These remaining processes are interfering the behavior of PST and CAP531 the next time these are started. To be able to shutdown these remaining processes, PST is provided with a small application called Process Terminator. The shutdown is straightforward which means that after clicking the Terminate button there are no point of return regarding unsaved data.

![Process Terminator - CAP531 and PST process terminator](image)

Figure 59: Process Terminator - CAP531 and PST process terminator

The application works like the Task Manager in Windows NT with the limitation to only effect the processes related to PST and CAP531. The GUI comprise of a list presentation of the currently remaining processes related to PST and/or CAP531, three buttons (Shutdown, Refresh and Exit) and a status bar showing current date, current operating system version and running mode. The title bar is also showing the name of the PC.
• **Start-up Process terminator**

To start ProcTerm.Exe, proceed according to the following display.

![Start-up Process terminator](image)

**Figure 60: Process Terminator - How to find and start**

• **Process Terminator functionality**

When ProcTerm.Exe is started the first appearance is according to the figure below. The appearance is modifiable by resizing the dialog, resizing column widths and sort order. Sort order is changed by clicking on the column header of the list.

![Process Terminator functionality](image)

**Figure 61: Process Terminator - Push buttons GUI**
Performing shutdown of the listed processes is made by clicking on the Terminate all button. After this is completed the following message is displayed.

![Refresh message](image)

*Figure 62: Process Terminator - Refresh message*

After the Refresh button has been clicked appearance is as following, note that Terminate all button is dimmed.

![Refreshed appearance](image)

*Figure 63: Process Terminator - Refreshed appearance*

- **Windows NT specific behavior**

Windows NT executes 16-bit programs in a specific way. There is a special process called NTVDM.EXE which handles all 16-bit programs. When the Process Terminator shuts down CAP 531 and PST programs it also looks for the NTVDM.EXE process to be able to shutdown CAP 531 which is a 16-bit program. Because other 16-bit programs may be running the shutdown of the NTVDM.EXE program is prompted.
How to use PST

At this point there is a possibility to skip, by selecting No in the message box, the termination of the remaining CAP 531 processes and save unsaved data for the other 16-bit programs. After this, return back to the Process Terminator to repeat the shutdown.

Figure 64: Process Terminator - Confirmation dialog
6 Graphical User Interface (GUI)

This chapter describes the graphical user interface of the PST. It explains the different parts such as the windows, the menus, the tool bar and the status bar. It also defines the names for the parts in the user interface, that are used throughout this manual.

The Main window and the Differences window are described in this chapter.

6.1 Main window

![Image of the main window of the parameter tool]

*Figure 65: The main window of the parameter tool*

When the parameter tool starts the main window according to figure 65 appears. At top of this window there is a title bar, a menu bar and a tool bar. At left there is a browsing sub-window called the Terminal Tree and at right there is a presentation sub-window called the Parameter View. At the bottom there is a status bar.

6.1.1 Terminal tree

Shows the structure in which the parameters for a terminal instance are organized. The folders can be expanded and collapsed by double-clicking them or by clicking on the plus and minus signs in front of the folder icon.
1 Terminal level
2 Terminal sub-levels
3 Parameter level

*Figure 66: The levels in the terminal tree*

**Table 8: Icons in the terminal tree**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Represents...</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Terminal instance icon" /></td>
<td>The terminal instance.</td>
</tr>
<tr>
<td><img src="image" alt="Closed terminal sub level icon" /></td>
<td>A closed terminal sub level.</td>
</tr>
<tr>
<td><img src="image" alt="Opened terminal sub level icon" /></td>
<td>An opened terminal sub level.</td>
</tr>
<tr>
<td><img src="image" alt="Closed configuration parameter level icon" /></td>
<td>A closed configuration parameter level.</td>
</tr>
<tr>
<td><img src="image" alt="Opened configuration parameter level icon" /></td>
<td>An opened configuration parameter level.</td>
</tr>
</tbody>
</table>
6.1.2 Parameter view

When the terminal level or a terminal sub-level is selected in the terminal tree, the contents of that level are shown in the parameter view to the right. When you double-click a level in the parameter view, you will see its contents. You can continue to double-click levels until a list of parameters is shown.

When a parameter level is selected in the terminal tree, a list of parameters is shown, see figure 65. For each parameter you will see its name, its value in the terminal, its value in PST and the unit. The terminal value field is empty if the parameters never have been read from the terminal - otherwise the values originate from the last time they were read from the terminal. The terminal value fields are also updated when writing to the terminal when the flag “Read back all values after a Write to Terminal” is set.

You can change the parameter value by editing input fields of the PST Values. A changed value is shown in bold and in the color blue, see figure 67.

Moving the cursor over a parameter name, results in a tool tip with a description of the parameter. Moving the cursor over the parameter input field, results in a tool tip with information on the ranges and steps for the parameter in question.

Table 8: Icons in the terminal tree (Continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Represents...</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>A closed parameter level containing writable parameters.</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>An open parameter level containing writable parameters.</td>
</tr>
</tbody>
</table>

Figure 67: Parameter view with changed values and tool tips
If the values do not fit in a Terminal Value field, you get ... (three dots) presented to the right of the field. Moving the cursor over the field, results in that the whole value is presented as shown in the figure below.

![Figure 68: Presentation of large Terminal values](image)

### 6.1.2.1 Special parameter view

For Internal Events in the terminal families REX500 and RET521, the parameters are presented in a different way than the default one. This is shown in the figure below.

![Figure 69: Parameter view for Internal Events.](image)

### 6.1.3 Menus

This chapter describes briefly all menus and the commands in them. The detailed usage of the commands are described in chapter “How to use PST” on page 23.
6.1.3.1 File menu

![File menu interface](image)

*Figure 70: File menu*

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Button</th>
<th>Short-cut key</th>
<th>Select this command to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td><img src="image" alt="Save icon" /></td>
<td>&lt;CTRL&gt; + &lt;S&gt;</td>
<td>Save all the changes you have made.</td>
</tr>
<tr>
<td>Save latest read</td>
<td></td>
<td></td>
<td>Save the latest uploaded terminal values to the PST values.</td>
</tr>
<tr>
<td>Compress</td>
<td></td>
<td></td>
<td>Save the terminal instance as a compressed file.</td>
</tr>
<tr>
<td>Decompress</td>
<td></td>
<td></td>
<td>Open a compressed file for a terminal instance.</td>
</tr>
<tr>
<td>Template - Save</td>
<td><img src="image" alt="Template icon" /></td>
<td></td>
<td>Save the terminal instance as a template.</td>
</tr>
<tr>
<td>Template - Open</td>
<td></td>
<td></td>
<td>Open a template for a terminal instance.</td>
</tr>
<tr>
<td>Print...</td>
<td><img src="image" alt="Print icon" /></td>
<td>&lt;CTRL&gt; + &lt;P&gt;</td>
<td>Print the parameters.</td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td></td>
<td>Exit PST.</td>
</tr>
</tbody>
</table>
6.1.3.2 Edit menu

![Edit menu screenshot](image)

*Figure 71: Edit menu*

**Table 10: Edit menu commands**

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Button</th>
<th>Short-cut key</th>
<th>Select this command to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Settings</td>
<td></td>
<td></td>
<td>Copy parameter values from one setting group to another.</td>
</tr>
<tr>
<td>Customize</td>
<td></td>
<td></td>
<td>Customize the behavior of PST.</td>
</tr>
<tr>
<td>Terminal options</td>
<td></td>
<td></td>
<td>Import terminal options from file in order to adjust function library for efficient off-line engineering</td>
</tr>
<tr>
<td>Rated current</td>
<td></td>
<td></td>
<td>Adjust the rated current in off-line mode.</td>
</tr>
<tr>
<td>Copy Parameter Data</td>
<td></td>
<td></td>
<td>Copy parameter data from the current terminal instance to a buffer</td>
</tr>
<tr>
<td>Paste Parameter Data</td>
<td></td>
<td></td>
<td>Paste parameter data from the buffer to the current terminal instance</td>
</tr>
</tbody>
</table>

6.1.3.3 View menu

![View menu screenshot](image)

*Figure 72: View menu*
### Table 11: View menu commands

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Button</th>
<th>Short-cut key</th>
<th>Select this command to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tool bar</td>
<td></td>
<td>&lt;F5&gt;</td>
<td>Show or hide the tool bar.</td>
</tr>
<tr>
<td>Differences</td>
<td></td>
<td></td>
<td>Show the differences between the parameter values in the tool and the values earlier read from the terminal.</td>
</tr>
<tr>
<td>Setting Group</td>
<td></td>
<td></td>
<td>View another setting group.</td>
</tr>
<tr>
<td>Refresh</td>
<td></td>
<td>&lt;F5&gt;</td>
<td>Redraws the PST window.</td>
</tr>
</tbody>
</table>

#### 6.1.3.4

**Online menu**

![Image of online menu](image)

**Figure 73: Online menu**

### Table 12: Online menu commands

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Button</th>
<th>Short-cut key</th>
<th>Select this command to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read From Terminal</td>
<td></td>
<td></td>
<td>Read all parameter values from the terminal.</td>
</tr>
<tr>
<td>Read from Terminal</td>
<td></td>
<td></td>
<td>Read the parameter values under the selected level, from the terminal.</td>
</tr>
<tr>
<td>Write to Terminal</td>
<td></td>
<td></td>
<td>Write all parameter values to the terminal.</td>
</tr>
<tr>
<td>Write to Terminal</td>
<td></td>
<td></td>
<td>Write parameter values under the selected level in the terminal tree, to the terminal.</td>
</tr>
<tr>
<td>Read Options</td>
<td></td>
<td></td>
<td>Read the options from the terminal. (Only visible when the terminal family supports options)</td>
</tr>
<tr>
<td>Compare with Terminal</td>
<td></td>
<td></td>
<td>Compare the parameter values in the tool and in the terminal. At first, this command reads the parameter values from the terminal.</td>
</tr>
<tr>
<td>Setup</td>
<td></td>
<td></td>
<td>Setup the communication parameters.</td>
</tr>
</tbody>
</table>
6.1.3.5 Help menu

![Help menu screen](image)

*Figure 74: Help menu*

**Table 13: Help menu commands**

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Button</th>
<th>Short-cut key</th>
<th>Select this command to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents and index.</td>
<td>![Question Mark]</td>
<td></td>
<td>Start Help for PST.</td>
</tr>
<tr>
<td>About PST</td>
<td></td>
<td></td>
<td>Get information on tool and module versions.</td>
</tr>
</tbody>
</table>

6.1.4 Tool bar

The functions in the tool bar are explained in figure 75.

![Tool bar screen](image)

*Figure 75: Tool bar*

If you move the cursor over the items in the tool bar you get a tool tip.
6.2 Differences window

When you select ‘Differences’ in the ‘View’ menu or ‘Compare with Terminal’ in the ‘Online’ menu in the main window, the following window appears.

![Figure 76: Differences window](image)

For every parameter for every setting group that are not equal in the Terminal value field and in the PST value field, a line is presented in the window. The lines are organized with headlines who represent the parameter levels in the terminal tree.

The status bar shows how many differences that were found.

6.2.1 Menus

This section describes briefly all menus and commands in the Differences window.

The detailed usage of the commands are described in section “View differences” on page 45.

6.2.1.1 File menu

![Figure 77: Differences file menu](image)
Table 14: Differences file menu commands

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Button</th>
<th>Short-cut key</th>
<th>Select this command to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td></td>
<td></td>
<td>Save the differences as semicolon(;) separated file.</td>
</tr>
<tr>
<td>Print</td>
<td></td>
<td></td>
<td>Print the differences.</td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td></td>
<td>Exit the differences window.</td>
</tr>
</tbody>
</table>

6.2.1.2 Help menu

There is only one command in the Help menu that starts when clicking at the help item in the menu bar:

Table 15: Differences help command

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Button</th>
<th>Short-cut key</th>
<th>Select this command to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents and index</td>
<td></td>
<td></td>
<td>Start the help page for the Differences window.</td>
</tr>
</tbody>
</table>

6.3 Help

This section describes how you get help on using the tool and how you get help on the parameters.

You can also start the help system by clicking Contents and index on the Help menu, as well as from the tool bar button and then find your topic in the index or by browsing for it in the help structure.

To get help on a parameter, move the cursor over the parameter name in the parameter view, and you will get a tool tip with description of the parameter in question. Instead, if moving the cursor over the input field, you get a tool tip with information on ranges and steps of the parameter.
This chapter explains errors and messages and gives you hints what to do if they occur.

### Table 16: System errors and messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Explanation</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Addressed data impossible to read or write.</td>
<td>Addressed data impossible to read or write due to a permanent or temporary blockade.</td>
<td>Make a new terminal instance and try again. If you still have the problem, call for technical support on PST.</td>
</tr>
<tr>
<td>Checksum or parity error.</td>
<td>Error in the checksum or parity of the data send to the terminal.</td>
<td>Restart your PC and try again. If you still have the problem call for technical support on PST.</td>
</tr>
<tr>
<td>Connect DDE failed.</td>
<td>Failed to establish a DDE connection between Communication object and SPA Bus.</td>
<td>Restart PST and try again and if you still have the problem, call for technical support on PST.</td>
</tr>
<tr>
<td>Data in write message is not validated.</td>
<td>Format of the data in write message is not validated.</td>
<td>Make a new terminal instance and try again. If you still have the problem, call for technical support on PST.</td>
</tr>
<tr>
<td>Failed to start SPA-Bus.exe.</td>
<td>Starting of SPABus Failed.</td>
<td>Restart PST and try again. If you still have the problem call for technical support on PST.</td>
</tr>
<tr>
<td>Message too complicated for terminal.</td>
<td>Message from master is too complicated for the terminal.</td>
<td>Make a new instance and try again. If you still have the problem, call for technical support on PST.</td>
</tr>
<tr>
<td>Registry error.</td>
<td>An error related to setting or getting data from registry.</td>
<td>Delete the terminal from the navigator, make a new terminal and then try again. If you still have the problem call for technical support on PST.</td>
</tr>
<tr>
<td>Serial Number does not match.</td>
<td>The serial number received from the terminal does not match with the serial number of the previous terminal communication.</td>
<td>Try again and if you get a message that ask you about overwriting the current serial number, answer Yes.</td>
</tr>
<tr>
<td>Slave is busy.</td>
<td>The terminal is currently busy with another job.</td>
<td>Wait a short while and try again. Restart the terminal if you still have the problem.</td>
</tr>
<tr>
<td>Syntax error.</td>
<td>Incorrect or unrecognized message type.</td>
<td>Make a new terminal instance and try again. If you still have the problem, call for technical support on PST.</td>
</tr>
</tbody>
</table>
Table 16: System errors and messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Explanation</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminal Type does not match.</td>
<td>The PST module and the terminal to communicate have different types.</td>
<td>Check that you have selected right type of terminal when you created the instance. If the problem remains delete the terminal from the navigator and make a new instance, make sure that you select the right type of terminal. If you still have the problem call for technical support on PST.</td>
</tr>
<tr>
<td>The terminal do not contain all data requested in message.</td>
<td>Terminal does not contain all data requested in the message.</td>
<td>Make a new terminal instance and try again. If you still have the problem, call for technical support on PST.</td>
</tr>
<tr>
<td>Time out.</td>
<td>No response from the terminal.</td>
<td>Check the communication parameters and restart the PST. If you still has the problem restart the terminal and PST.</td>
</tr>
<tr>
<td>Undefined negative acknowledgment.</td>
<td>Undefined negative acknowledgment, it can be an internal error in communication program.</td>
<td>Restart PST and try again and if you still have the problem, call for technical support on PST.</td>
</tr>
</tbody>
</table>
NOTICE TO USER: PLEASE READ THIS CONTRACT CAREFULLY. BY USING ALL OR ANY PORTION OF
THE SOFTWARE YOU ACCEPT ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT, INCLUDING, IN
PARTICULAR THE LIMITATIONS ON: USE CONTAINED IN SECTION 2; TRANSFERABILITY IN SECTION 4;
WARRANTY IN SECTION 6 AND 7; AND EXPORT RULES IN SECTION 8. YOU AGREE THAT THIS AGREEMENT
IS ENFORCEABLE LIKE ANY WRITTEN NEGOTIATED AGREEMENT SIGNED BY YOU. IF YOU DO
NOT AGREE, DO NOT USE THIS SOFTWARE. IF YOU ACQUIRED THE SOFTWARE ON TANGIBLE MEDIA
(e.g. CD) WITHOUT AN OPPORTUNITY TO REVIEW THIS LICENSE AND YOU DO NOT ACCEPT THIS
AGREEMENT, YOU MAY OBTAIN A REFUND OF ANY AMOUNT YOU ORIGINALLY PAID IF YOU: (A) DO NOT
USE THE SOFTWARE AND (B) RETURN IT, WITH PROOF OF PAYMENT, TO THE LOCATION FROM WHICH
IT WAS OBTAINED WITHIN THIRTY (30) DAYS OF THE PURCHASE DATE.

1. Definitions. “Software” means (a) all of the contents of the files, disk(s), CD-ROM(s) or other media with which
this Agreement is provided, including but not limited to (i) ABB or third party computer information or software; (ii)
related explanatory written materials or files (“Documentation”); and (iii) fonts; and (b) upgrades, modified ver-
ions, updates, additions, and copies of the Software, if any, licensed to you by ABB (collectively, “Updates”).
“Use” or “Using” means to access, install, download, copy or otherwise benefit from using the functionality of the
Software in accordance with the Documentation. “Permitted Number” means one (1) unless otherwise indicated
under a valid license (e.g. Corporate Software License) granted by ABB. “Computer” means an electronic device
that accepts information in digital or similar form and manipulates it for a specific result based on a sequence of
instructions. ”Terminal” means protection and control terminal with serial communication supported by the Soft-
ware. By “ABB” this document is referring to ABB Automation Technologies AB, Substation Automation, Västerås,
Sweden.

2. Software License. As long as you comply with the terms of this Software License Agreement (this “Agree-
ment”), ABB grants to you a non-exclusive license to Use the Software for the purposes described in the Docu-
mentation. Some third party materials included in the Software may be subject to other terms and conditions,
which are typically found in a “Read Me” file located near such materials.

2.1. General Use. You may install and Use a copy of the Software on your compatible computer, up to the Permit-
ted Number of computers.

2.1.1. Single License. The Single Software License Agreement grants the user to install the software on a single
 corporate computer.

2.1.2. Corporate License. Customers with a Corporate License are granted to install the software on any number
of corporate computers without a limitation on the maximum Permitted Number of computers.

2.2. Backup Copy. With Single Licence you may make one backup copy of the Software, provided your backup
 copy is not installed or used on any computer. You may not transfer the rights to a backup copy unless you transfer
all rights in the Software as provided under Section 4. The Corporate License grants the User to make backup
copies of the software without limitation to the maximum Permitted Number.

2.3. Home Use. You, as the primary user of the computer on which the Software is installed, may also install the
Software on one of your home computers. However, the Software may not be used on your home computer at the
same time the Software on the primary computer is being used.

2.4. No Modification. You may customize or extend the functionality of the installer for the Software as specifically
allowed by instructions found at www.abb.com/substationautomation or (e.g., installation of additional plug-in and
help files). You may not otherwise alter or modify the Software or create a new installer for the Software. The Soft-
ware is licensed and distributed by ABB for viewing, changing and up/downloading parameters and configuration
files for ABB’s terminals. You are not authorized to integrate or use the Software with any other software.

3. Intellectual Property Rights. The Software and any copies that you are authorized by ABB to make are the
intellectual property of and are owned by ABB. The structure, organization and code of the Software are the valu-
able trade secrets and confidential information of ABB and its suppliers. You may not copy the Software, except as
set forth in Section 2 (“Software License”). Any copies that you are permitted to make pursuant to this Agreement
must contain the same copyright and other proprietary notices that appear on or in the Software. Unless specifically and expressly permitted by ABB, you agree not to modify, adapt or translate the Software. You also agree not to reverse engineer, de-compile, disassemble or otherwise attempt to discover the source code of the Software. Trademarks shall be used in accordance with accepted trademark practice, including identification of trademarks owners’ names. Trademarks can only be used to identify printed output produced by the Software and such use of any trademark does not give you any rights of ownership in that trademark. Except as expressly stated herein, this Agreement does not grant you any intellectual property rights in the Software and all rights not expressly granted herein are reserved by ABB.

4. Transfer. You may not transfer education, pre-release, or not for resale copies of the Software.

5. Multiple Environment Software / Multiple Language Software / Dual Media Software / Multiple Copies / Bundles / Updates. If the Software supports multiple platforms or languages, if you receive the Software on multiple media, if you otherwise receive multiple copies of the Software, or if you received the Software bundled with other software, the total number of your computers on which all versions of the Software are installed may not exceed the Permitted Number. You may not transfer the Software to another person or legal entity provided that: (a) you also transfer this Agreement, the Software and all other software or hardware bundled or pre-installed with the Software, including all copies, Updates and prior versions, and all copies of data files, to such person or entity; (b) you retain no copies, including backups and copies stored on a computer; and (c) the receiving party accepts the terms and conditions of this Agreement and any other terms and conditions upon which you legally purchased a license to the Software. Notwithstanding the foregoing, you may not transfer education, pre-release, or not for resale copies of the Software.

6. Pre-release Product Additional Terms. If the product you have received with this license is pre-commercial release or beta Software ("Pre-release Software"), then the following Section applies. To the extent that any provision in this Section is in conflict with any other term or condition in this Agreement, this Section shall supersede such other term(s) and condition(s) with respect to the Pre-release Software, but only to the extent necessary to resolve the conflict. You acknowledge that the Software is a pre-release version, does not represent final product from ABB, and may contain bugs, errors and other problems that could cause system or other failures and data loss. Consequently, the Pre-release Software is provided to you "AS-IS", and ABB disclaims any warranty or liability obligations to you of any kind. WHERE LEGALLY LIABILITY CANNOT BE EXCLUDED FOR PRE-RELEASE SOFTWARE, BUT IT MAY BE LIMITED, ABB’S LIABILITY AND THAT OF ITS SUPPLIERS SHALL BE LIMITED TO THE SUM OF FIFTY DOLLARS (U.S. $50) IN TOTAL. You acknowledge that ABB has not promised or guaranteed to you that Pre-release Software will be announced or made available to anyone in the future, that ABB has no express or implied obligation to you to announce or introduce the Pre-release Software and that ABB may not introduce a product similar to or compatible with the Pre-release Software. Accordingly, you acknowledge that any research or development that you perform regarding the Pre-release Software or any product associated with the Pre-release Software is done entirely at your own risk. During the term of this Agreement, if requested by ABB, you will provide feedback to ABB regarding testing and use of the Pre-release Software, including error or bug reports. If you have been provided the Pre-release Software pursuant to a separate written agreement, such as an ABB Agreement for Unreleased Products, your use of the Software is also governed by such agreement. You agree that you may not and certify that you will not sublicense, lease, loan, rent, or transfer the Pre-release Software. Upon receipt of a later unreleased version of the Pre-release Software or release by ABB of a publicly released commercial version of the Software, whether as a stand-alone or as part of a larger product, you agree to return or destroy all earlier Pre-release Software received from ABB and to abide by the terms of the User License Agreement for any such later versions of the Pre-release Software. Pre-release software may be delivered separately or together as part of a released product.

7. LIMITATION OF LIABILITY. ABB IS NOT LIABLE FOR ANY DAMAGES TO YOUR PC AND/OR LAN (LOCAL AREA NETWORK) CAUSED BY THE SOFTWARE. IN NO EVENT WILL ABB OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY DAMAGES, CLAIMS OR COSTS WHATSOEVER OR ANY CONSEQUENTIAL, INDIRECT, INCIDENTAL DAMAGES, OR ANY LOST PROFITS, SAVINGS, BUSINESS, REVENUE, GOODWILL, ANTICI-
PATED SAVINGS, EVEN IF AN ABB REPRESENTATIVE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH LOSS, DAMAGES, CLAIMS OR COSTS OR FOR ANY CLAIM BY ANY THIRD PARTY, FITNESS FOR A PARTICULAR PURPOSE. THE FOREGOING LIMITATIONS AND EXCLUSIONS APPLY TO THE EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION. ABB’S AGGREGATE LIABILITY AND THAT OF ITS SUPPLIERS UNDER OR IN CONNECTION WITH THIS AGREEMENT SHALL BE LIMITED TO THE AMOUNT PAID FOR THE SOFTWARE.

8. Export Rules. You agree that the Software will not be shipped, transferred or exported into any country or used in any manner prohibited by the United States Export Administration Act or any other export laws, restrictions or regulations (collectively the "Export Laws"). In addition, if the Software is identified as export controlled items under the Export Laws, you represent and warrant that you are not a citizen, or otherwise located within, an embargoed nation (including without limitation Iran, Iraq, Syria, Sudan, Libya, Cuba, North Korea, and Serbia) and that you are not otherwise prohibited under the Export Laws from receiving the Software. It is expressly agreed that the Software shall not be used by you for planning, construction, maintenance, operation or use, directly or indirectly, in nuclear power plants, missile technology, chemical or biological weapons applications or flight, navigation or communication of aircraft or ground support equipment. All rights to Use the Software are granted on condition that such rights are forfeited if you fail to comply with the terms of this Agreement.

The interpretation and application of these licence terms and conditions shall be governed by the laws of Sweden. Disputes between you and ABB arising from these licence terms and conditions shall be resolved by a Swedish court, in the first instance by the Stockholm District Court.

If you have any questions regarding this Agreement or if you wish to request any information from ABB please use the address and contact information included with this product to contact the ABB office serving your jurisdiction.